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Preface

IBM® SPSS® Modeler is the IBM Corp. enterprise-strength data mining workbench. SPSS Modeler helps
organizations to improve customer and citizen relationships through an in-depth understanding of data.
Organizations use the insight gained from SPSS Modeler to retain profitable customers, identify
cross-selling opportunities, attract new customers, detect fraud, reduce risk, and improve government
service delivery.

SPSS Modeler's visual interface invites users to apply their specific business expertise, which leads to
more powerful predictive models and shortens time-to-solution. SPSS Modeler offers many modeling
techniques, such as prediction, classification, segmentation, and association detection algorithms. Once
models are created, IBM SPSS Modeler Solution Publisher enables their delivery enterprise-wide to
decision makers or to a database.

About IBM Business Analytics
IBM Business Analytics software delivers complete, consistent and accurate information that
decision-makers trust to improve business performance. A comprehensive portfolio of business
intelligence, predictive analytics, financial performance and strategy management, and analytic
applications provides clear, immediate and actionable insights into current performance and the ability to
predict future outcomes. Combined with rich industry solutions, proven practices and professional
services, organizations of every size can drive the highest productivity, confidently automate decisions
and deliver better results.

As part of this portfolio, IBM SPSS Predictive Analytics software helps organizations predict future events
and proactively act upon that insight to drive better business outcomes. Commercial, government and
academic customers worldwide rely on IBM SPSS technology as a competitive advantage in attracting,
retaining and growing customers, while reducing fraud and mitigating risk. By incorporating IBM SPSS
software into their daily operations, organizations become predictive enterprises – able to direct and
automate decisions to meet business goals and achieve measurable competitive advantage. For further
information or to reach a representative visit http://www.ibm.com/spss.

Technical support
Technical support is available to maintenance customers. Customers may contact Technical Support for
assistance in using IBM Corp. products or for installation help for one of the supported hardware
environments. To reach Technical Support, see the IBM Corp. web site at http://www.ibm.com/support.
Be prepared to identify yourself, your organization, and your support agreement when requesting
assistance.

v

http://www-01.ibm.com/software/data/businessintelligence/
http://www-01.ibm.com/software/data/businessintelligence/
http://www-01.ibm.com/software/analytics/spss/
http://www-01.ibm.com/software/data/cognos/financial-performance-management.html
http://www-01.ibm.com/software/data/cognos/products/cognos-analytic-applications/
http://www-01.ibm.com/software/data/cognos/products/cognos-analytic-applications/
http://www.ibm.com/spss
http://www.ibm.com/support
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Chapter 1. Getting started

Administered servers
Server administration in IBM SPSS Collaboration and Deployment Services Deployment Manager
involves:
1. Adding the server to be administered to the system.
2. Logging in to the server being administered.
3. Performing administrative tasks for the server as needed.
4. Logging off from the server being administered.

The Server Administration tab offers access to this functionality. This tab lists the servers currently
available to be administered. This list persists across IBM SPSS Collaboration and Deployment Services
Deployment Manager sessions, facilitating access to those servers.

From the menus choose:

Tools > Server Administration

The administered server list may include a variety of server types, including IBM SPSS Collaboration and
Deployment Services Repository servers, IBM SPSS Modeler servers, and IBM SPSS Statistics servers. The
actual administrative functionality available for a server depends on the server type. For example,
security providers can be configured and enabled for repository servers but not for IBM SPSS Modeler
servers.

Adding new administered servers
Before performing administrative tasks, a connection to the administered server must be established.

From the menus choose:

File > New > Administered Server Connection

The Add New Administered Server dialog box opens. Adding a new connection requires the specification
of the administered server type and the administered security server information.

Selecting the administered server name and type
The first step of adding a new administered server to the system involves the definition of the name and
type for the server.

Name. A label used to identify the server on the Server Administration tab. Including the port number in
the name, such as my_server:8080, may help to identify the server in the administered server list.

Note: Alphanumeric characters are recommended. The following symbols are prohibited:
v Quotation marks (single and double)
v Ampersands (&)
v Less-than (<) and greater-than (>) symbols
v Forward slash (/)
v Periods
v Commas
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v Semicolons

Type. The type of server being added. The list of possible server types depends on the system
configuration and may include:
v IBM SPSS Collaboration and Deployment Services Repository Server
v Administered IBM SPSS Modeler Server
v Administered IBM SPSS Statistics Server
v Administered IBM SPSS Modeler Text Analytics Server

Selecting an administered server type

In the Select Administered Server Type dialog box:
1. Enter a name for the server.
2. Select the server type.
3. Click Next. The Administered Server Information dialog box opens.

Administered server information
The second step of adding a new administered server to the system involves the definition of the server
properties.

For an IBM SPSS Collaboration and Deployment Services Repository server, you can specify the server
URL.

The URL includes the following elements:
v The connection scheme, or protocol, as either http for hypertext transfer protocol or https for hypertext

transfer protocol with the secure socket layer (SSL)
v The host server name or IP address

Note: An IPv6 address must be enclosed in square brackets, such as [3ffe:2a00:100:7031::1].
v The port number. If the repository server is using the default port (port 80 for http or port 443 for

https), the port number is optional.
v An optional custom context path for the repository server

Table 1. Example URL specifications. This table lists some example URL specifications for server connections.

URL Scheme Host Port
Custom
path

http://myserver HTTP myserver default
(80)

(none)

https://9.30.86.11:443/spss HTTPS 9.30.86.11 443 spss

http://[3ffe:2a00:100:7031::1]:9080/ibm/cds HTTP 3ffe:2a00:100:7031::1 9080 ibm/cds

Contact your system administrator if you are unsure of the URL to use for your server.

For other server types, available properties include the following items:

Host The name or IP address of the server.

Note: Alphanumeric characters are recommended. The following symbols are prohibited:
v Quotation marks (single and double)
v Ampersands (&)
v Less-than (<) and greater-than (>) symbols
v Forward slash (/)
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v Periods
v Commas
v Semicolons

Port The port number that is used for the server connection.

This is a secure port.
Enables or disables the use of a Secure Sockets Layer (SSL) for the server connection. This option
is not offered for all types of administered servers.

Note: To use the Administration Console with a server setup for SSL, you must import any
certificates required by Modeler Server into the Deployment Manager trust store (under
../jre/lib/security).

After you define the properties, the new server is included in the administered server list on the Server
Administration tab.

Viewing administered server properties
To view the properties of an existing administered server, right-click the server on the Server
Administration tab and select Properties from the drop-down menu.

The displayed properties depend on the type of server selected.

IBM SPSS Modeler Server Properties

For IBM SPSS Modeler servers, the properties include:
v Server name. Name of the machine on which IBM SPSS Modeler server is installed.
v Server version. Version of IBM SPSS Modeler server.
v Server operating system. Operating system of the machine on which IBM SPSS Modeler server is

installed.
v Server memory. Amount of RAM available on the machine on which IBM SPSS Modeler server is

installed..
v Available processors. Number of processors available on the IBM SPSS Modeler server machine.

Properties for IBM SPSS Modeler servers cannot be modified.

Connecting to administered servers
For most servers, you must connect to a server in the administered server list to perform administrative
tasks. From the Server Administration tab, double-click the server to administer.

Disconnecting administered servers
After completing your administrative tasks, log off from the server.
1. On the Server Administration tab, right-click the server.
2. Select Logoff.

To administer the server, you must log in again.
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Deleting administered servers
A server appears in the administered server list until it is deleted from the list.
1. On the Server Administration tab, select the server to delete.
2. From the menus choose:

Edit > Delete

Alternatively, right-click the server and select Delete from the drop-down menu.

If further administrative tasks for the server are needed in the future, the server will need to be added to
the system again.
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Chapter 2. Installing IBM SPSS Modeler Administration
Console

The following instructions are for installing IBM SPSS Modeler Administration Console. For a description
of Modeler Administration Console, see Chapter 3, “Using IBM SPSS Modeler Administration Console,”
on page 7.

System Requirements for Modeler Administration Console
To view the system requirements for Modeler Administration Console, go to http://www.ibm.com/
software/analytics/spss/products/modeler/requirements.html.

Note: Modeler Administration Console can be installed only on Windows computers; however, it can
administer an SPSS Modeler Server installed on any supported platform.
v SPSS Modeler software. SPSS Modeler Server release 12.0 or newer must be installed on the network.
v Additional requirements. The IBM SPSS Modeler Administration Console host computer must have

network connectivity to the computer hosting IBM SPSS Modeler Server.

Installing Modeler Administration Console
To Install Modeler Administration Console
1. Insert the SPSS Modeler Server installation disk into your disk drive. The AutoPlay feature presents a

menu.
2. On the AutoPlay menu, click Install Modeler Administration Console and then follow the instructions

that appear on the screen.
3. To start the console, follow the instructions under “Starting Modeler Administration Console” on page

7.

To Use an Existing Deployment Manager Installation

If you have already installed a version of Deployment Manager to administer other server applications
from IBM Corp., you can add the SPSS Modeler Server administration functionality to your existing
Deployment Manager installation.

Follow the procedure shown under To Install Modeler Administration Console, being sure to install in the
same directory as your existing IBM SPSS Collaboration and Deployment Services Deployment Manager
installation (for example, C:\Program Files\IBM\SPSS\Collaboration and Deployment Services\4.<n>\
Deployment Manager). The installer will add the new IBM SPSS Modeler Server files to the existing
installation.

© Copyright IBM Corporation 1994, 2013 5
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Chapter 3. Using IBM SPSS Modeler Administration Console

The Modeler Administration Console application provides a console user interface to monitor and
configure your SPSS Modeler Server installations, and is available free-of-charge to current SPSS Modeler
Server customers. The application can be installed only on Windows computers; however, it can
administer a server installed on any supported platform.

Many of the options available through Modeler Administration Console can also be specified in the
options.cfg file, which is located in the SPSS Modeler Server installation directory under /config. However,
the Modeler Administration Console application provides a shared graphical interface that allows you to
connect, configure, and monitor multiple servers.

Starting Modeler Administration Console
From the Windows Start menu, choose [All] Programs, then IBM SPSS Collaboration and Deployment
Services, then Deployment Manager, then IBM SPSS Modeler Administration Console <nn.n>.

When you first run the application, you see empty Server Administration and Properties panes (unless
you already have Deployment Manager installed with an IBM SPSS Collaboration and Deployment
Services server connection already set up). After you configure Modeler Administration Console, the
Server Administrator pane on the left displays a node for each SPSS Modeler Server that you want to
administer. The right-hand pane shows the configuration options for the selected server. You must first
set up a connection for each server that you want to administer.

Configuring Access with Modeler Administration Console
Administrator access to SPSS Modeler Server through Modeler Administration Console is controlled with
the administrators line in the options.cfg file, located in the SPSS Modeler Server installation directory
under /config. This line is commented out by default, so you must edit this line to allow access to specific
people, or use * to allow access to all users, as shown in the following examples:
administrators, "*"
administrators, "jsmith,mjones,achavez"

v The line must begin with administrators, and the entries must be contained in quotation marks.
Entries are case sensitive.

v Separate multiple user IDs with commas.
v For Windows accounts, do not use domain names.
v Use the asterisk with care. It allows anyone with a valid user account for IBM SPSS Modeler Server

(which, in most cases, is anyone on the network) to log in and change the configuration options.

Configuring Access with User Access Control
To use the Modeler Administration Console to make updates to a SPSS Modeler Server configuration
installed on a Windows machine that has User Access Control (UAC) enabled you must have read, write,
and execute permissions defined on the config directory and on the options.cfg file. These (NTFS)
permissions must be defined at the specific user level and not at group level, this is due to the way that
UAC and NTFS permissions interact.

© Copyright IBM Corporation 1994, 2013 7



SPSS Modeler Server Connections
You must specify a connection to each SPSS Modeler Server on your network that you want to
administer. You must then log in to each server. Although the server connection is remembered across
Modeler Administration Console sessions, the login credentials are not. You must log in every time you
start Modeler Administration Console.

To Set Up a Server Connection

1. Ensure that the IBM SPSS Modeler Server service is started.
2. From the File menu, choose New and then Administered Server Connection.
3. On the first page of the wizard, enter a name for your server connection. The name is for your own

use and should be something descriptive; for example, Production Server. Ensure that Type is set to
Administered IBM SPSS Modeler Server, then click Next.

4. On the second page, enter the hostname or IP address of the server. If you have changed the port
from the default, enter the port number. Click Finish. The new server connection is shown in the
Server Administrator pane.

To perform administration tasks, you must now log in.

To Log in to the Server

1. In the Server Administrator pane, double-click to select the server to which you want to log in.
2. In the Login dialog box, enter your credentials. (Use your user account for the server host.) Click OK.

If the login fails with the message Unable to obtain administrator rights on server, the most likely cause
is that administrator access has not been configured correctly. See the topic “Configuring Access with
Modeler Administration Console” on page 7 for more information.

If the login fails with the message Failed to connect to server '<server>', make sure that the user ID and
password are correct, then make sure that the IBM SPSS Modeler Server service is running. For example,
under Windows, go to Control Panel > Administrative Tools > Services and check the entry for IBM SPSS
Modeler Server. If the Status column does not show Started, select this line on the screen and click Start,
then retry the login.

Once you log in to your IBM SPSS Modeler Server, two options are shown below the server name,
Configuration and Monitoring. Double-click one of these options.

SPSS Modeler Server Configuration
The Configuration pane shows configuration options for SPSS Modeler Server. Use this pane to change
the options as desired. Click Save on the toolbar to save the changes. (Note that changing the port
number requires a server restart in order to take effect.)

The options are described in the following sections, with the corresponding line in options.cfg given in
parentheses for each option. Options that are visible only in options.cfg are described at the end of this
section.

Connections/Sessions
Maximum number of connections. (max_sessions) Maximum number of server sessions at one time. A
value of –1 indicates no limit.

Port number. (port_number) The port number for SPSS Modeler Server to listen on. Change if another
application already uses the default. End users must know the port number in order to use SPSS Modeler
Server.
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Analytic Server Connection
Analytic Server URL. (as_url) The URL of the Analytic Server, including the IP address of the server, the
port, and the tenant the SPSS Modeler Server installation is a member of.

Prompt for Password. (as_prompt_for_password) Specify N if the SPSS Modeler Server is configured with
the same authentication system for users and passwords as that used on Analytic Server; otherwise, Y.

Data File Access
Restrict access to only data file path. (data_files_restricted) When set to yes, this option restricts data
files to the standard data directory and those listed in the Data File Path below.

Data file path. (data_file_path) A list of additional directories to which clients are allowed to read and
write data files. This option is ignored unless the Restrict Access to Only Data File Path option is turned
on. Note that you should use forward slashes in all pathnames. Specify multiple directories using
semicolons (for example, [server install path]/data;c:/data;c:/temp).

Restrict access to only program files path. (program_files_restricted) When set to yes, this option
restricts program file access to the standard bin directory and those listed in the Program Files Path
below.

Program files path. (program_file_path) A list of additional directories from which clients are allowed to
execute programs. This option is ignored unless the Restrict Access to Only Program Files Path option is
turned on. Note that you should use forward slashes in all pathnames. Specify multiple directories using
semicolons.

Maximum file size (MB). (max_file_size) Maximum size of temporary and exported data files created
during stream execution (does not apply to SAS and SPSS Statistics data files). A value of –1 indicates no
limit.

Temporary directory. (temp_directory) The directory used to store temporary data files (cache files).
Ideally, this directory should be on a separate high-speed drive or controller because speed of access to
this directory may have a significant impact on performance. You may specify multiple temporary
directories, separating each with a comma. These should be located on different disks; the first directory
is used most often, and additional directories are used to store temporary work files when certain data
preparation operations (such as sort) use parallelism during execution. Allowing each execution thread to
use separate disks for temporary storage can improve performance. Use forward slashes in all path
specifications. Note: Temporary files are generated in this directory during startup of SPSS Modeler
Server. Ensure that you have the necessary access rights to this directory (for example, if the temporary
directory is a shared network folder), otherwise SPSS Modeler Server startup will fail.

Python Exe Path. (python_exe_path) Full path to the python executable including the executable name.
Note that Restrict access to only program files path may need to be set to No depending on the location
where python is installed.

Performance/Optimization
Stream rewriting. (stream_rewriting_enabled) Allows the server to optimize streams by rewriting them.
For example, the server might push data reduction operations closer to the source node to minimize the
size of the dataset as early as possible. Disabling this option is normally recommended only if the
optimization causes an error or other unexpected results. This setting overrides the corresponding client
optimization setting. If this setting is disabled in the server, then the client cannot enable it. But if it is
enabled in the server, the client can choose to disable it.

Parallelism. (max_parallelism) Describes the number of parallel worker threads that SPSS Modeler is
allowed to use when running a stream. Setting this to 0 or any negative number causes IBM SPSS
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Modeler to match the number of threads to the number of available processors on the computer; the
default value for this option is –1. To turn off parallel processing (for machines with multiple processors),
set this option to 1. To allow limited parallel processing, set it to a number smaller than the number of
processors on your machine. Note that a hyperthreaded or dual-core processor is treated as two
processors.

Buffer size (bytes). (io_buffer_size) Data files transferred from the server to the client are passed
through a buffer of this number of bytes.

Cache compression. (cache_compression) An integer value in the range 0 to 9 that controls the
compression of cache and other files in the server’s temporary directory. Compression reduces the
amount of disk space used, which can be important when space is limited, and improves performance by
reducing the amount of disk activity needed to create and read the cache. Compression increases
processor time, but this is almost always made up by the reduction in disk access time. Note that only
certain caches, those accessed sequentially, can be compressed. This option does not apply to
random-access caches, such as those used by the network training algorithms. A value of 0 disables
compression entirely. Values from 1 upward provide increasing degrees of compression but with a
corresponding cost in access time. The default value is 1; higher values are rarely needed except where
disk space is at a premium.

Memory usage multiplier. (memory_usage) Controls the proportion of physical memory allocated for
sorting and other in-memory caches. The default is 100, which corresponds to approximately 10% of
physical memory. Increase this value to improve sort performance where free memory is available, but be
careful of increasing it so high as to cause excessive paging.

Modeling memory limit percentage. (modelling_memory_limit_percentage) Controls the proportion of
physical memory allocated for training neural net, Kohonen, and k-means models. The default is 25%.
Increase this value to improve training performance where free memory is available, but be careful of
increasing it so high as to cause excessive paging when data spills onto the disk.

Allow modeling memory override. (allow_modelling_memory_override) Enables or disables the Optimize
for Speed option in certain modeling nodes. The default is enabled. This option allows the modeling
algorithm to claim all available memory, bypassing the percentage limit option. You may want to disable
this if you need to share memory resources on the server machine.

Maximum and minimum server port. (max_server_port and min_server_port) Specifies the range of port
numbers that can be used for the additional socket connections between client and server that are
required for interactive models and stream execution. These require the server to listen on another port;
not restricting the range could cause problems for users on systems with firewalls. Default value for both
is –1, meaning "no restriction." Thus, for example, to set the server to listen on port 8000 or above, you
would set min_server_port to 8000 and max_server_port to –1.

Note that you must open additional ports over the main server port to open or execute a stream, and
correspondingly more ports if you want to open or execute concurrent streams. This is required in order
to capture feedback from the stream execution.

By default, IBM SPSS Modeler will use any open port that is available; if it does not find one (for
example, if they are all closed by a firewall), an error is displayed when you execute the stream. To
configure the range of ports, IBM SPSS Modeler will need two open ports (in addition to the main server
port) available per concurrent stream, plus an additional port for each connected client that has an ODBC
connection. To execute more concurrent streams, you can widen the range of port numbers and open up
more ports on the firewall accordingly.

Note: Best practice dictates that the same ports should be used to communicate with both IBM SPSS
Collaboration and Deployment Services and SPSS Modeler Client. These can be set as max_server_port
and min_server_port.
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Note: If you change these parameters, you need to restart SPSS Modeler Server for the change to take
effect.

Array fetch optimization. (sql_row_array_size) Controls the way that SPSS Modeler Server fetches data
from the ODBC datasource. The default value is 1, which fetches a single row at a time. Increasing this
value causes the server to read the information in larger chunks, fetching the specified number of rows
into an array. With some operating system/database combinations, this can result in improvements to the
performance of SELECT statements.

SQL
Maximum SQL string length. (max_sql_string_length) For a string imported from the database with
SQL, the maximum number of characters that are guaranteed to be passed successfully. Depending on the
operating system, string values longer than this may be truncated on the right without warning. The
valid range is between 1 and 65,535 characters. This property also applies to the Database export node.

Note: The default value for this parameter is 2048. If the text you are analyzing is longer than 2048
characters (for example, this may occur if using the SPSS Modeler Text Analytics Web Feed node) we
recommend increasing this value if working in native mode otherwise your results may be truncated. If
you are using a database and user-defined functions (UDF), this restriction does not occur; this can
account for differences in results between native and UDF modes.

Automatic SQL generation. (sql_generation_enabled) Allows automatic SQL generation for streams,
which may substantially improve performance. The default is enabled. Disabling this option is
recommended only if the database is not able to support queries submitted by SPSS Modeler Server. Note
that this setting overrides the corresponding client optimization setting; also note that for purposes of
scoring, SQL generation must be enabled separately for each modeling node regardless of this setting. If
this setting is disabled in the server, then the client cannot enable it. But if it is enabled in the server, the
client can choose to disable it.

Default SQL string length. (default_sql_string_length). Specifies the default width of string columns
that will be created within database cache tables. String fields in database cache tables will be created
with a default width of 255 if there is no upstream type information. If you have wider values than this
in your data, either instantiate an upstream Type node with those values, or set this parameter to a value
that is large enough to accommodate those string values.

Support SQL type logging. (supported_sql_type_logging). For debug purposes only; do not modify
unless instructed to do so by a technical-support representative.

Enable Database UDF. (db_udf_enabled). If set to Y (default), causes the SQL generation option to
generate user-defined function (UDF) SQL instead of pure SPSS Modeler SQL. UDF SQL usually
outperforms pure SQL.

SSL
Enable SSL. (ssl_enabled) Enables SSL encryption for connections between SPSS Modeler and SPSS
Modeler Server.

Keystore. (ssl_keystore) The SSL key database file to be loaded when the server starts (either a full path
or a relative path to the SPSS Modeler installation directory.

Keystore stash file. (ssl_keystore_stash_file) The name of the key database password stash file to be
loaded when the server starts up (either a full path or a relative path to the SPSS Modeler installation
directory).

Keystore label. (ssl_keystore_label) Label for the specified certificate.
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Note: To use the Administration Console with a server setup for SSL, you must import any certificates
required by SPSS Modeler Server into the Deployment Manager trust store (under ../jre/lib/security).

Coordinator of Processes Configuration
Host. (cop_host) The hostname or IP address of the Coordinator of Processes service. The default
“spsscop” is a vanity name which administrators can choose to add as an alias for the IBM SPSS
Collaboration and Deployment Services host in DNS.

Port number. (cop_port_number) The port number of the Coordinator of Processes service. The default,
8080, is the IBM SPSS Collaboration and Deployment Services default.

Context root. (cop_context_root) The URL of the Coordinator of Processes service.

Login name. (cop_user_name) The user name for authentication to the Coordinator of Processes service.
This is an IBM SPSS Collaboration and Deployment Services login name so may include a
security-provider prefix (for example: ad/jsmith).

Password. (cop_password) The password for authentication to the Coordinator of Processes service.

Enabled. (cop_enabled) Determines whether the server should attempt to register with the Coordinator of
Processes. The default is not to register because the administrator should choose which services are
advertised through the Coordinator of Processes.

Server name. (cop_service_name) The name of this SPSS Modeler Server instance; the default is the host
name.

Description. (cop_service_description) A description of this instance.

Update interval (min). (cop_update_interval) The number of minutes between keep-alive messages; the
default is 2.

Weight. (cop_service_weight) The weight of this instance, specified as an integer between 1 and 10. A
higher weight attracts more connections. The default is 1.

Service host. (cop_service_host) The fully-qualified host name of the IBM SPSS Modeler Server host. The
default of the host name is derived automatically; the administrator can override the default for
multi-homed hosts.

Options Visible in options.cfg
administrators. Specify the usernames of those users to whom you want to grant administrator access.
See the topic “Configuring Access with Modeler Administration Console” on page 7 for more
information.

allow_config_custom_overrides. Do not modify unless instructed to do so by a technical-support
representative.

fips_encryption. Enables FIPS compliant encryption; the default is N.

max_transfer_size. For internal system use only; do not modify.

shell. (UNIX servers only) Overrides the default setting for the UNIX shell, for example shell,
"/usr/bin/ksh". By default, IBM SPSS Modeler uses the shell defined in the user profile of the user who
is connecting to IBM SPSS Modeler Server.
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start_process_as_login_user. Set this to Y if you are running SPSS Modeler Server with a private
password database.

time_ecode_execution_log. Set this to Y if you want the message.log file (in the log folder of the SPSS
Modeler Server installation) to include individual execution times for each node in the stream.

use_bigint_for_count. When the number of the records to be counted is larger than a normal integer
(2^32-1) can hold, set this option to Y. When this option is set to Y, and a stream is connected to either
DB2 or SQL Server, COUNT_BIG() will be used where a record count is needed (for example, the
Record_Count field generated by the Aggregate node).

SPSS Modeler Server Monitoring
The monitoring pane of Modeler Administration Console shows a snapshot of all processes running on
the SPSS Modeler Server computer, similar to the Windows Task Manager. To activate the monitoring
pane, double-click the Monitoring node beneath the desired server in the Server Administrator pane. This
populates the pane with a current snapshot of data from the server. The data refreshes at the rate shown
(one minute by default). To refresh the data manually, click the Refresh button. To show only SPSS
Modeler Server processes in this list, click the Filter out non-SPSS Modeler processes button.

Chapter 3. Using IBM SPSS Modeler Administration Console 13
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Chapter 4. Using IBM SPSS Text Analytics Administration
Console

The IBM SPSS Text Analytics Administration Console provides a user interface to monitor and configure
your IBM SPSS Modeler Text Analytics Server installations. The IBM SPSS Text Analytics Administration
Console can be installed only on Microsoft Windows computers; however, it can administer IBM SPSS
Modeler Text Analytics Server s installed on any supported platform.

You can also use the IBM SPSS Text Analytics Administration Console to manage your IBM SPSS Modeler
Text Analytics sessions as well as to manage web server connections. Specifically, if you chose to "save
and reuse" the Web Feed data or the Translate node translated text, you can delete this stored session
data once you no longer need it.

If you use console for IBM SPSS Modeler, the session data for IBM SPSS Modeler Text Analytics is
managed in the same window.

Starting IBM SPSS Text Analytics Administration Console
After you have installed and configured IBM SPSS Text Analytics Administration Console , the Server
Administrator pane on the left displays a node for each IBM SPSS Modeler Text Analytics Server that you
want to administer. The right-hand pane shows the configuration options for the selected server. When
you first run the application, both panes are blank.

To start IBM SPSS Text Analytics Administration Console :

From the Microsoft Windows Start menu, choose [All] Programs > IBM SPSS Modeler 16 IBM SPSS
Collaboration and Deployment Services Deployment Manager > IBM SPSS Text Analytics
Administration Console .

Server Configuration Settings
The Configuration pane shows configuration options for IBM SPSS Modeler Text Analytics Server . Use
this pane to change the options as desired and then choose File > Save from the menus to save the
changes.

Important! In order for your changes to take effect, you must restart the server web service.

Table 2. General server settings

Setting Description

Web Service Port
Number

The port number for IBM SPSS Modeler Text Analytics Server to listen on. Change if another
application already uses the default. End users must know the port number in order to use
IBM SPSS Modeler Text Analytics Server . After changing and saving, you must now update
the server properties with this new port number as well (Right-click the server on the Server
Administration tab and select Properties from the drop-down menu.) See the topic “Viewing
administered server properties” on page 3 for more information.

Initial Memory
Size (in MB)

The initial Java heap size to control the amount of memory that is allocated to JVM
application.

Maximum Memory
Size (in MB)

Maximum Java heap size. A value of –1 indicates no limit.
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Table 3. SSL parameters

Setting Description

Enable SSL Enables SSL encryption for connections between IBM SPSS Modeler Text Analytics and IBM
SPSS Modeler Text Analytics Server .
Note: To use the Administration Console with a server setup for SSL, you must import any
certificates required by SPSS Modeler Server into the Deployment Manager trust store (under
../jre/lib/security).

Private key file Enter the name of the PKCS-12 formatted keystore to be loaded when the server starts up.
Enter a filename here. Make sure the file is located in the following subdirectory of the IBM
SPSS Modeler Server installation directory:

v On Microsoft Windows: \ext\bin\spss.TMWBServer\lib

v On UNIX: /ext/bin/spss.TMWBServer/lib

To generate this keystore, run a GSKit command with the key database filename (.kdb file,
certificate label, and password) that was used to configure SSL for IBM SPSS Modeler. For
example:

gsk8apicmd.exe -cert -export -db <keystore_filename>.kdb -pw <password>
-label <certificate label> -target <keystore_filename>.p12 -target_type pkcs12
-target_pw

In this example, <keystore_filename>.p12 is the name of the PKCS-12 keystore to be used with
IBM SPSS Modeler Text Analytics Server

Private key
password

Password key for the specified certificate. Enter the target password that was used in the
previous command to generate PKCS-12 certificate file..

Note for UNIX platforms: The Java Cryptography Engine (JCE) shipped with some JVMs do not support
all the cryptographic algorithms required by various specification used within the Identity Provider. In
these cases, the BouncyCastle JCE is invoked to provide this support. To enable BouncyCastle JCE, you
will need to edit the file java.security located in the <modeler_server_install>/ext/bin/
spss.TMWBServer/jre/lib/security directory by adding the following line after the last
security.provider entry: security.provider.#=org.bouncycastle.jce.provider.BouncyCastleProvider
where # is replaced with a number one greater than the last provider in the list.

Note for Apache Axis2: Due to an update for Apache Axis2 in the product (starting from IBM SPSS
Modeler 15 FP1), you must ensure that your SSL certificate has been regenerated to incorporate the
update that verifies the hostname. This update requires a valid fully qualified hostname in the CN field;
this is because the CN field provided in the certificate is now compared with the hostname used by the
client when requesting an Axis2 service. When you have regenerated the certificate you must connect to
the IBM SPSS Modeler Text Analytics Server through the Administration Console by using the fully
qualified hostname otherwise the connection will fail.

Table 4. Logging parameters

Setting Description

Logging Level This indicates the level of logging that should be performed. Possible values are: NONE,
DEBUG, INFO, WARN, ERROR, or FATAL.

Maximum Logging
File Size (in KB)

This setting is the largest amount of space a log file can grow before the log file is rolled. The
size is specified in kilobytes. This parameter accepts only numerical values. The default value
of 0 disables log rolling.

Maximum Number of
Log Files

This setting is the maximum number of log files to save before deleting the older ones. The
default value of 0 means that there is no maximum number of logs.
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Server Session Table
IBM SPSS Text Analytics Administration Console 's session pane shows a snapshot of all sessions running
on the IBM SPSS Modeler Text Analytics Server computer.
1. To activate the session pane, double-click the Session node beneath the desired server in the Server

Administrator pane. The data refreshes at the rate shown (one minute by default).
2. To refresh the data manually, click the Refresh button.

SessionId. This is the session's internal identifier.

Description. In the case where you have chosen to save and reuse web feeds or translation results, the
label specified in the node is shown here. Otherwise a generic Text_Mining is shown.

Role. This column describes the role the session plays.

User Name. This is the username provided by the web server.

Temporary Directory. This is the directory path for the data generated by the session.

Timestamp. This is the date and time the session was started.

Persist. This indicates whether the session should be kept after a session has ended. When set to false,
this indicates that the entry should be deleted when a session terminates. When you have chosen to save
and reuse web feeds or translation results, Persist is set to true since you want to keep this data until you
choose to delete the session directly here.
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Chapter 5. Restarting Web Service

Whenever you make changes to either an IBM SPSS Modeler Server or IBM SPSS Modeler Text Analytics
Server in the Administration Console, you must restart the web service.

To restart the Web Service on Microsoft Windows:
1. On the computer where you installed IBM SPSS Modeler, select Services from Administrative Tools

on the Control Panel.
2. Locate IBM SPSS Modeler Server in the list and restart it.
3. Click OK to close the dialog box.

To restart the Web Service on UNIX:

On UNIX, you must restart the IBM SPSS Modeler Server by running the modelersrv.sh script in the IBM
SPSS Modeler Server installation directory.
1. Change to the IBM SPSS Modeler Server installation directory. For example, at a UNIX command

prompt, type:
cd /usr/<modelersrv>, where modelersrv is the IBM SPSS Modeler Server installation directory.

2. To stop the server, at the command prompt, type
./modelersrv.sh stop

3. To restart the server, at the command prompt, type
./modelersrv.sh start
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Notices

This information was developed for products and services offered worldwide.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Software Group
ATTN: Licensing
200 W. Madison St.
Chicago, IL; 60606
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at
“Copyright and trademark information” at www.ibm.com/legal/copytrade.shtml.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel Xeon,
Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel Corporation or its
subsidiaries in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.
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UNIX is a registered trademark of The Open Group in the United States and other countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or
its affiliates.

Other product and service names might be trademarks of IBM or other companies.
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